Outlook 2003

IMAP E-Mail
COPYRIGHT

Copyright ©2003 by EZ-REF Courseware, Laguna Beach, CA  http://www.ezref.com/  All rights reserved. This publication, including the student manual, instructor's guide and exercise files, or any part thereof, may not be reproduced or transmitted in any form or by any means, electronic or mechanical, without prior written permission of EZ-REF Courseware.

TRADEMARKS

EZ-REF is a trademark of EZ-REF Courseware. Other products and brand names mentioned are trademarks or registered trademarks of their respective holders.

DISCLAIMER

While EZ-REF Courseware has taken care to ensure the accuracy and quality of these materials, all material is provided without any warranty whatsoever, including, but not limited to, the implied warranties of merchantability or fitness for a particular purpose. Any persons or businesses mentioned in the text of this manual are strictly fictitious. Any resemblances to existing or deceased persons, or existing or defunct businesses, is entirely coincidental.

Product Code:  MS OUTLOOK 2003  3.6
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GETTING STARTED WITH OUTLOOK</td>
<td>5</td>
</tr>
<tr>
<td>THE OUTLOOK SCREEN</td>
<td>7</td>
</tr>
<tr>
<td>NAVIGATING WITHIN OUTLOOK</td>
<td>10</td>
</tr>
<tr>
<td>WORKING WITH MAIL</td>
<td>11</td>
</tr>
<tr>
<td>SIZING THE WINDOW PANES</td>
<td>15</td>
</tr>
<tr>
<td>CREATING A MESSAGE</td>
<td>16</td>
</tr>
<tr>
<td>SELECTING MULTIPLE ADDRESSES</td>
<td>17</td>
</tr>
<tr>
<td>TYPING YOUR MESSAGE</td>
<td>20</td>
</tr>
<tr>
<td>DELETING TEXT</td>
<td>21</td>
</tr>
<tr>
<td>UNDOING A DELETION</td>
<td>21</td>
</tr>
<tr>
<td>SETTING A PRIORITY</td>
<td>21</td>
</tr>
<tr>
<td>ENHANCING YOUR MESSAGE</td>
<td>22</td>
</tr>
<tr>
<td>ASSIGNING A NEW FONT</td>
<td>22</td>
</tr>
<tr>
<td>ADDING STYLE TAGS</td>
<td>23</td>
</tr>
<tr>
<td>TURNING ATTRIBUTES ON/OFF</td>
<td>23</td>
</tr>
<tr>
<td>CHANGING JUSTIFICATION</td>
<td>24</td>
</tr>
<tr>
<td>CHANGING THE COLOR OF THE FONT</td>
<td>24</td>
</tr>
<tr>
<td>INDENTING PARAGRAPHS</td>
<td>24</td>
</tr>
<tr>
<td>CREATING A NUMBERED LIST</td>
<td>25</td>
</tr>
<tr>
<td>ADDING A HORIZONTAL LINE</td>
<td>25</td>
</tr>
<tr>
<td>ADDING A SIGNATURE BLOCK</td>
<td>26</td>
</tr>
<tr>
<td>FLAGGING A MESSAGE</td>
<td>30</td>
</tr>
<tr>
<td>COMPLETING A FLAGGED MESSAGE</td>
<td>31</td>
</tr>
<tr>
<td>SETTING MISCELLANEOUS MESSAGE OPTIONS</td>
<td>32</td>
</tr>
<tr>
<td>USING THE SPELL CHECKER</td>
<td>35</td>
</tr>
<tr>
<td>DELIVERING/RECEIVING MESSAGES</td>
<td>38</td>
</tr>
<tr>
<td>IDENTIFYING UNREAD MESSAGES</td>
<td>39</td>
</tr>
<tr>
<td>SORTING MESSAGES</td>
<td>40</td>
</tr>
<tr>
<td>FINDING MESSAGES</td>
<td>41</td>
</tr>
<tr>
<td>CANCELING A SEARCH</td>
<td>42</td>
</tr>
<tr>
<td>CLEARING THE SEARCH RESULTS</td>
<td>42</td>
</tr>
<tr>
<td>READING MESSAGES</td>
<td>43</td>
</tr>
<tr>
<td>MARKING MESSAGES AS BEING READ/UNREAD</td>
<td>44</td>
</tr>
<tr>
<td>DELETING MESSAGES</td>
<td>45</td>
</tr>
<tr>
<td>DELETING ITEMS FROM YOUR IMAP FOLDERS</td>
<td>46</td>
</tr>
<tr>
<td>PURGING DELETED ITEMS</td>
<td>46</td>
</tr>
<tr>
<td>MANAGING DELETED ITEMS IN IMAP FOLDER VIEWS</td>
<td>47</td>
</tr>
<tr>
<td>HIDING DELETED ITEMS</td>
<td>48</td>
</tr>
<tr>
<td>GROUPING DELETED ITEMS</td>
<td>49</td>
</tr>
<tr>
<td>DELETING ITEMS FROM YOUR PERSONAL FOLDERS</td>
<td>50</td>
</tr>
<tr>
<td>PRINTING A MESSAGE</td>
<td>51</td>
</tr>
<tr>
<td>REPLYING TO A MESSAGE</td>
<td>52</td>
</tr>
<tr>
<td>FORWARDING A MESSAGE</td>
<td>53</td>
</tr>
<tr>
<td>WORKING WITH ATTACHMENTS</td>
<td>54</td>
</tr>
<tr>
<td>ATTACHING A FILE TO A MESSAGE</td>
<td>54</td>
</tr>
<tr>
<td>SAVING AN ATTACHMENT</td>
<td>56</td>
</tr>
<tr>
<td>OPENING AN ATTACHMENT</td>
<td>56</td>
</tr>
</tbody>
</table>
CUSTOMIZING THE VIEW ......................................................................................................................... 57

STORING MESSAGES.................................................................................................................................................. 59
  CREATING FOLDERS .............................................................................................................................................. 59
  MOVING A MESSAGE ............................................................................................................................................ 61
  RENAMING A FOLDER ........................................................................................................................................... 61
  DELETING A FOLDER ........................................................................................................................................... 62

WORKING WITH A CONTACT LIST .................................................................................................................. 63
  ADDING A CONTACT ........................................................................................................................................... 64
  ORGANIZING THE CONTACT LIST .................................................................................................................. 70
  SORTING CONTACTS ......................................................................................................................................... 71
  GROUPING CONTACTS ...................................................................................................................................... 73
  DELETING A CONTACT ....................................................................................................................................... 74
  UNDELETING A CONTACT ................................................................................................................................... 74
  CREATING SUB-GROUPS .................................................................................................................................... 75
  SENDING CONTACT INFORMATION VIA E-MAIL .............................................................................................. 76
  SAVING A VCARD ................................................................................................................................................. 77
  CREATING A MAILING LIST ............................................................................................................................... 78
  REMOVING A MEMBER FROM THE LIST ........................................................................................................... 81
  CLOSING THE ADDRESS BOOK WINDOW ......................................................................................................... 81

CHANGING OUTLOOK OPTIONS .................................................................................................................. 82
  SETTING PREFERENCES ....................................................................................................................................... 82
  MAIL SETUP ......................................................................................................................................................... 88
  MAIL FORMAT OPTIONS ..................................................................................................................................... 89
  SPELLING OPTIONS ............................................................................................................................................. 91
  SETTING OTHER OPTIONS .................................................................................................................................... 92
GETTING STARTED WITH OUTLOOK

USAGE:

Outlook’s messaging service allows you to create, send, read and organize your mail. Contact lists allow you to quickly look up an address or phone number for a client or colleague. The calendar can be used for scheduling appointments and tasks. You can also schedule meetings with other users by reviewing their calendars.

In addition, Outlook allows you to integrate files from other MS Office applications. For example, you could include an MS Word document with an e-mail message sent in Outlook.

You can run Outlook directly from the desktop, as shown below:

If you have a shortcut set up on your desktop, double-click on the Microsoft Outlook icon.

NOTE: Before actually using Outlook, you must define a user profile. This profile contains such information as your password, the e-mail service you will be using (e.g., MS Exchange, Internet Mail), your e-mail address, and fax services. Typically, your System Administrator will set up your profile. If not, the first time you run Outlook this information will be requested.

If you do not have a shortcut on your desktop, run the program by following the three steps shown below:

1. Click on this button (located on the far left side of the taskbar - at the bottom of the desktop) to access the Windows Start menu.

2. Select All Programs from the pop-up menu.
Select **Microsoft Office Outlook 2003** from the sub-menu.
THE OUTLOOK SCREEN

After running the program, you should notice that the window includes many of the standard elements common to most Windows applications as well as a few items that are unique to Outlook. The screen can be quite intimidating the first time you see it as there are so many items displayed on it. However, if you take a few minutes to familiarize yourself with the various screen elements, the program will become easier to work with.

Across the top of the Outlook window is the **Title Bar** which displays the name of the currently displayed Outlook object (Inbox) as well as the application. In the far left corner is a small Outlook icon (referred to as the “Control Icon”) which is used to access a pull-down menu containing selections for changing the window’s size and placement. In the upper right corner are the three standard Windows buttons for minimizing, maximizing/restoring the window, and closing the program.
The second line is referred to as the **Menu Bar** and contains all of the commands required to use this application. You can access any menu item by simply pointing to it and clicking the **[LEFT]** mouse button once. Notice that each menu item has one underlined letter which can be used in conjunction with the **[ALT]** key to access the menu directly through the keyboard. Once the menu is opened, you may notice icons to the left of some of the options. If a menu item could have been accessed via the tool bar, Outlook displays these tool bar icons along the left side of the opened menu to help you associate the menu item with the correct icon.

Some menus provide additional options which are not immediately displayed. To access these extra options, you can either click on the **[down]** button (at the bottom of the menu) or double-click the menu.

To the right side of the menu bar is a help box where you may enter a quick question. Simply click in the **Ask a Question** box and type your question (such as “how do I print”) and press the **[E]** key. Outlook will run its help feature and display the help topics most closely associated with the question you entered.

The **Standard Tool Bar** is located on the third line and can be used to quickly perform functions without having to access the menu. If you point to a tool without clicking the mouse button, a brief description of the tool will appear.

The **Advanced Tool Bar** can be displayed by choosing View, Toolbars from the menu and then selecting Advanced from the list of toolbars.

Combined with the standard tool bar is the formatting tool bar. Because these two tool bars are combined, if your screen is not maximized, you may not be able to see all of the tools on both bars. Instead, Outlook offers an additional button **[to access the hidden tools. Once you select a tool that was previously hidden, Outlook displays it directly on the standard or**
formatting tool bar for future use. This allows you to personalize the tool bars to display the tools you most often use. In addition, some tool bars contain an extra button that can be used to add or remove tools.

The Navigation Pane is displayed beneath the tool bar along the left side of the window. This pane displays both the folder list as well as the various items (e.g., Calendar, Contacts, Tasks) within Outlook. The right portion of the window changes as you select items from the left side (within the Navigation Pane). There is a folder banner across the top of the right section, indicating the currently selected folder (item).

The Status Bar is located at the bottom of the window. This bar contains information relevant to the currently selected item (chosen from the Outlook Bar on the left side of the window). For example, if the Inbox folder is selected, this line displays the number of messages as well as the number of unread messages.
NAVIGATING WITHIN OUTLOOK

USAGE:

Before working in Outlook, you must be able to locate the desired item of information from the list provided in the Navigation Pane (located along the left side of the Outlook window).

The top portion of the navigation pane displays a list of your folders while the bottom portion of the pane lists the various Outlook items (such as your Mail, Calendar, Contacts, Tasks and Notes).

The top portion of the navigation pane changes as you select one of the Outlook items described below:

- **Mail**: This item is used to access your mail.
- **Calendar**: Displays the appointment book where you can schedule appointments or meetings.
- **Contacts**: Stores names, phone numbers, and addresses of contacts.
- **Tasks**: Displays a To-Do (Task) list.
- **Notes**: Stores general data (e.g., new ideas).
- **Folder List**: Displays all of your folders.
- **Shortcuts**: Contains any shortcuts you might have created along with anything you have scheduled for the current date (appointments, tasks). You can also access the Internet to see if there are any program updates.
WORKING WITH MAIL

USAGE:

If you have an IMAP account at Princeton, your mail messages are delivered to your Inbox folder on that server. In addition, you may have other folders on the server, as well as a complete local folder system (stored on the hard drive of your computer).

Mail folders typically located on the IMAP server:

- **Inbox**: New messages are delivered here.

- **Sent Items**: Copies of messages you send to others are stored here (note that you may also choose to save these to a local folder).

- **Drafts**: Copies of messages you have started but are not yet ready to send may be stored here.

- **Spam**: If you are using Princeton’s spam filtering, you may have a server folder to receive the spam.

- **Junk E-Mail**: You may identify senders of junk email to Outlook and request that mail from those senders be delivered here instead of your inbox.
The following mail folders are available:

**Deleted Items** Temporarily stores deleted items. To permanently remove the items marked for deletion when you exit Outlook, you can access the **Tools → Options → Other** menu and then check the box labeled “Empty Deleted Items folder upon exiting”.

**Drafts** Stores messages started but not completed.

**Inbox** Contains messages sent to you.

**Junk E-mail** This folder is used to store messages Outlook signals as being unsolicited items.

**Outbox** Temporarily stores messages you create until they are delivered.

**Sent Items** Stores copies of messages you have sent.

Depending on your system, you may have additional folders.

Your first step in using Outlook’s messaging feature is to switch to the Inbox, as shown below:

Be sure that you have chosen to work with your mail.

Next, select your Inbox as the folder to view.
The left side of the Inbox window contains a list of messages while the right side of the window displays the actual contents of the currently selected message.

If for some reason you do not see the preview pane, access the View ➔ Reading Pane menu and then select where you want the reading pane displayed.

By default, Outlook places it to the right, as shown below:

The messages are arranged by date with the newest message on top. As you click on each message, the preview on the right side of the screen changes to display the currently selected message.
You can also choose to display the message preview beneath the Inbox, as shown in the diagram below:

Notice the top half of the window contains several columns of information for each message. The first column (↓) indicates whether the message has a low (represented by a down arrow) or high (the exclamation mark) priority. The second column ([]) displays the type of message (such as e-mail or delivery confirmation). The third column (ﬁles) indicates a file has been attached to the message.

The fourth column displays the name of the author while the fifth column displays the subject. The sixth column lists the date/time that the message was received.

The seventh column displays the size of the message while the final column (✓) specifies whether the message requires a response from the recipient. A red flag indicates an action is required while a white flag indicates the action is completed.
SIZING THE WINDOW PANE

To change the size of the top and bottom or left and right window panes, place the tip of the mouse on the line separating the two panes you wish to modify.

The mouse pointer will change to a double-sided arrow (as shown in the picture on the left).

Hold down the [LEFT] mouse button and then drag the mouse to increase/decrease the size of the current pane. When done, release the button.
CREATING A MESSAGE

USAGE:

The first step in using any electronic mail package is usually to prepare and then send a message to another user. When sending messages, you have the ability to send courtesy copies of the message to users you think might want or need to view the message you are preparing.

You also have the ability of sending what is referred to as a Blind Courtesy Copy which, unlike a courtesy copy, allows you to send a copy of a message without the addressee being aware that a copy has been sent to another user.

Outlook allows you to request a receipt that will notify you when the message was delivered and/or read.

To create a new message, follow the steps outlined below:

1. Click on this tool to create a new message. If you click on the down arrow, you can choose to create a different type of entry.
Click in the To: section and enter the address you want to send the new message to.

If you are unsure of the spelling, click on this button and choose from a list of stored addresses.

**SELECTING MULTIPLE ADDRESSES**

To select **contiguous** addresses, move to the first address and click once. Move the mouse to the last address to select and hold the [Shift] key down as you click once.

To select **noncontiguous** addresses, hold the [Ctrl] key down as you click on each address to be included.
CHOOSING THE ADDRESSEE DESIGNATION

Select whether the message is being sent \( T \rightarrow \) (the main recipient), as a \( \text{Cc} \rightarrow \) (a courtesy copy is being furnished to another user) or as a \( \text{Bcc} \rightarrow \) (blind courtesy copy).

Click on the down arrow \( \checkmark \) beside the box labeled **Show Names from the** to choose the address book from which you want to select the addressee.

To choose someone from your corporation or workgroup, select the Global Address List - which contains all of the user and distribution lists within your organization. Notice you can also select someone from your **Contacts** folder.

You can choose your **Personal Address Book** which is a separate file stored on your computer containing the e-mail addresses of your personal contacts. However, Microsoft recommends you store personal addresses within the Contacts folder so that you can use all of the Outlook features (such as filtering and meeting requests).

Click on \( \text{Advanced} \) to access additional features, such as adding a new contact, changing the properties associated with the currently selected contact, searching for a contact using one of the many directories available over the Internet, or specifying options for sending a message.

When done selecting an address, choose \( \text{OK} \) to close the Address Book. You will be returned to the “New Message” window.
The Bcc section is not visible when you first enter the "New Message" window. To add a section for a Bcc (Blind courtesy copy) without accessing the Address Book shown in the previous step, access the View → Bcc Field menu. The main recipient of this message will not see the name(s) of the people receiving Bcc copies of the message.

Click in the Subject: section and enter a very brief description for the new message. This is important as the recipient will see this subject in their Inbox as a header explaining what the message deals with.

You now need to click in the Contents area and begin typing the actual contents of the new message. Text will wrap from one line to the next as you continue to type.

Click on this button to send the message to your Outbox. Outlook will periodically check for new mail and send messages stored in your Outbox.

To send the message immediately, click on this tool which will send all mail in your Outbox and check for new mail.

If you click on the down arrow beside this tool you can specify which accounts to check as well as how much to download (e.g., headers only).
TYPING YOUR MESSAGE

Although you can use the formatting tool bar to assign attributes and change the font and point size of the message text, many Internet users will not be able to see these attributes.

NOTE: If you know that a contact cannot view a message containing rich text attributes (e.g., bold, italics), you can permanently specify that this contact should only receive plain text messages by accessing the Properties box of the contact via the Address Book.

TIP: You can quickly add a hyperlink to an Internet address by simply typing the URL address within your message. Outlook will convert the address to a hyperlink that can be clicked on by the recipient to access the Web page.

The recipient must, however, have a mail application that can recognize the address as a hyperlink!

These movement keys may be used while preparing a message:

- **CTRL + →**: Moves to the next word.
- **CTRL + ←**: Moves to the previous word.
- **HOME**: Moves to the beginning of the current line.
- **END**: Moves to the end of the current line.
- **CTRL + HOME**: Moves to the beginning of the message.
- **CTRL + END**: Moves to the end of the message.

If you prefer using the mouse to move, simply click where you would like the cursor to move. You may also need to use the scroll bars located to the right and across the bottom of the screen - if you fill in more than a screenful of text.
DELETING TEXT

While editing, use the [Backspace] key to delete text to the left of the cursor or the [Delete] key to delete the current character.

If you prefer using the mouse, click and drag to highlight the block of text to be removed and then press the [Delete] key.

UNDOING A DELETION

If you delete something by mistake, access the Edit → Undo menu or press [Ctrl]+[Z] to undo the deletion (or last action).

SETTING A PRIORITY

Click on this button to set a high priority. An exclamation mark (!) will be attached to the icon in the recipient’s Inbox.

Click on this button to set a low priority. A down arrow will be attached to the icon in the recipient’s Inbox.
ENHANCING YOUR MESSAGE

USAGE:
You may want to enhance a message by assigning a different font or applying attributes to the message text.

NOTE: All formatting options are only available if you chose to create the message using the Rich Text or HTML format. Keep in mind that not all recipients will be able to view these formatting changes!

ASSIGNING A NEW FONT
When creating a new message, you can emphasize a block of message text by changing its font.

1. Click on the down arrow to the right of the Font tool. Notice that a sample is provided in the list for each font.

   Arial

2. Select the desired font from the pull-down list.

NOTE: To apply the new font to an existing block of text, select the text first and then choose the desired font.

CHANGING THE POINT SIZE

1. Click on the down arrow to the right of the Font Size tool on the tool bar.

   10

2. Select the desired font size from the pull-down list.

NOTE: To apply the new size to an existing block of text, select the text first and then choose the desired size.
ADDING STYLE TAGS

If you chose to use the HTML format for sending messages, you can use the same standard HTML styles and formatting codes that are used to customize your Web pages.

To change the format for the message, access the Tools ➔ Options ➔ Mail Format menu. Under the section labeled “Message format”, select HTML.

NOTE: If the contact's e-mail program cannot read HTML, the message will appear garbled. Before sending a message using HTML styles, be sure the contact’s e-mail package is able to display HTML codes.

To assign one of the pre-defined styles to a selected block of text, access the Format ➔ Style menu and then select the desired style from the list provided. These styles are based on standard HTML styles and sizes.

TURNING ATTRIBUTES ON/OFF

To apply an attribute, click on one of the tools shown below. After turning the attribute on, type the desired text and then click the tool a second time to turn the attribute off. To apply the attribute to existing text, select the text first and then click the tool.

- Click on this tool to turn Bold on and off.
- Click on this tool to turn Italics on and off.
- Click on this tool to turn Underline on and off.
CHANGING JUSTIFICATION

To alter the alignment of a paragraph, place your cursor anywhere in the paragraph and select one of the following buttons:

- Left Justified
- Centered
- Right Justified

CHANGING THE COLOR OF THE FONT

Click on this button to change the color of the font. A palette will be displayed, listing all available colors.

To choose a color, click on the color from within the palette. If you choose Automatic, Outlook resets the color to its default setting (which is black).

INDENTING PARAGRAPHS

You can also indent a paragraph - which temporarily changes its margins. Place your cursor in the paragraph to modify and click on one of these buttons to increase/decrease the indent:

- Click on this button to indent a paragraph.
- Click on this tool to outdent a paragraph.
TURNING BULLETS ON

To include a bullet list within your message, select the **Bullet** tool. A bullet will precede each new line. Select the bullet tool a second time to turn bullets off.

**NOTE:** If you had selected existing text, each selected paragraph would be preceded with a bullet.

CREATING A NUMBERED LIST

To include a numbered list within your message, select the **Numbering** tool. A number will precede each new line. Select the tool a second time to turn numbers off.

**NOTE:** If you had selected existing text, each selected paragraph would be preceded with a number.

ADDING A HORIZONTAL LINE

Select this tool to add a horizontal line at the current cursor location within your new message.

Once the line is added to your message, you can change the color of the line by clicking on it once (to select it) and then using the color tool ( ).

You can also change the thickness or length of the line by clicking on it once (to select it) and then dragging one of the small white handles ( ) up/down to adjust the width or left/right to adjust the length. If your memo is based on a stationery template (discussed later), you may not be able to change the line color.

To remove the line, select it and press [DEL].

**NOTE:** Lines are only available with HTML format messages!
ADDING A SIGNATURE BLOCK

You can add a signature block to the end of the new message.

1. Click on this button to add a signature.

If you prefer accessing the menu:

MENU:

Insert
File...
Item...
Signature

Horizontal Line
Picture...
Hyperlink...
Remove Hyperlink

2. From the pull-down list, select the signature to be inserted in the message.

If you have more signature files than are listed or want to preview your signatures before selecting one, select More... from the bottom of the pull-down menu.

If you have never created a signature block file, the following message will appear when you choose “More...” from the list:

You don't have any HTML signatures to insert into the message. Would you like to create one now?

Yes  No

Click on Yes to create a new signature file.
You will be taken to a dialog box, as shown below:

1. Enter a name for your new signature:
   Untitled

2. Choose how to create your signature:
   - Start with a blank signature
   - Use this existing signature as a template:
   - Use this file as a template:

Browse...

Enter a name for the new signature file in the box provided.

You can also choose whether you want to create the file from scratch or use an existing signature to base the new signature block on. For example, if you already have a business signature created, you can edit it and then use it for your personal correspondence.

In addition, you can base the new signature on an existing file by clicking on Browse... to search your system for the file. However, the format of the file must match the format of your message (such as HTML or Rich Text).
When done, click on `Next >` to move to the next dialog box:

In the box labeled **Signature text**, enter the text to be used for the signature block you are creating.

- **Font...** Click on this button to assign a font, point size and text attributes for the new signature block.
- **Paragraph...** Click on this button to apply paragraph formatting codes to the new signature block. These codes include alignment and whether bullets will be included in the signature.
- **Clear** Click on this button to clear the contents of the signature box so you can start from scratch.
- **Advanced Edit...** Click on this button to launch a separate program for editing the signature block. For example, Notepad will be used if you are using Plain Text messages.
vCard options

Use this section to attach a vCard to each message you send. A “vCard” is a special file which contains business, personal, and other contact information in one file. Basically, it is a virtual business card. By attaching a vCard with all of your information, mail recipients can quickly add you to their Address Book without having to manually type in the contact data.

If your address information is stored as a contact, click on **New vCard from Contact...** to create a vCard from the contact info.

**TIP:** To create a vCard for yourself, simply add a new contact to your Address Book with all of your relevant information and use that contact for the vCard.

When done, click on **Finish** to complete the signature.

**NOTE:** If you want to create additional signature blocks, you will need to access the **Tools → Options → Mail Format** menu. Select the **Signatures...** button (which is located in the lower right corner of the dialog box - within the “Signature” section).

**TIP:** To have a signature block automatically included in all of your outgoing messages, access the **Tools → Options → Mail Format** menu.
FLAGGING A MESSAGE

If you want to flag a message with a special instruction, Outlook provides several predefined flags from which to choose. For example, you can add an instruction to call, reply or follow up on the message you are sending.

Click on this tool to set a flag for the current message. A dialog box appears, as shown below:

Flagging marks an item to remind you that it needs to be followed up. After it has been followed up, you can mark it complete.

Flag to: Follow up
Flag color: 
Due by: None

Clear Flag  OK  Cancel

The box is divided into the following sections:

Flag to: Click on the down arrow beside this item to specify the type of flag you want to set. For example, the response you may desire is a reply to the message. To select one of these flags, click on the flag type from the pull-down list.

Call  Do not Forward  Follow Up  For Your Information  Forward  No Response Necessary  Read  Reply

Click on the Clear Flag button to remove (clear) an existing flag.
Due by: Depending on the type of flag that you set, you may want to specify a reminder date. Click on the down arrow beside this item to specify the date you would like to be reminded of the flag.

Use the arrows on either side of the currently displayed month to switch between them. Notice you can insert the current date (Today) as well as a button for not including a reminder date (None).

Flag color: Click on the down arrow beside this option to assign a color to the flag.

Click on the down arrow beside this option to specify a time.

Once everything is complete, click on OK.

Outlook will place a small note at the top of the message indicating what type of response is required and when it is due:

Reply by Thursday, March 18, 2003 5:00 PM.

COMPLETING A FLAGGED MESSAGE

If you wish to mark a flagged message as having been completed, select the message and then access the Actions → Follow Up... menu and click on the Flag Complete checkbox.
SETTING MISCELLANEOUS MESSAGE OPTIONS

Outlook allows you to change such options as message importance, sensitivity, encryption and specific delivery options all within a single dialog box.

Click on this button to set multiple mail options.

The following dialog box will be displayed:

Message settings

<table>
<thead>
<tr>
<th>Importance:</th>
<th>Normal</th>
<th>Change security settings for this message.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity:</td>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>

Voting and Tracking options

- Use voting buttons: 
- Request a delivery receipt for this message
- Request a read receipt for this message

Delivery options

- Have replies sent to: [Select Names...]
- Save sent message to: [Browse...]
- Do not deliver before: [None] 12:00 AM
- Expires after: [None] 12:00 AM
- Attachment format: [Default]
- Encoding: [Auto-Select]

Message settings

Use this section to specify the importance level of the current message and its sensitivity. These settings alert the recipient of a message that needs to be read immediately or one that is sensitive in nature.

Click on the down arrow beside each option to change its setting.
Security

Use this section to specify whether the current message should be encrypted during transmission for security purposes and if a digital signature should be attached to it.

Voting and Tracking options

If you need a yes/no or an approve/reject type reply, use this section to choose the type of voting that can be used. The recipient’s vote will be sent back to you via e-mail. Also use this section if you want to be notified when the message has been delivered and/or read.

Delivery options

This section contains several checkboxes.

When a person replies to a message, the reply is automatically addressed to the user who originally sent the message. If, however, you would like the reply addressed to another user, check the box labeled Replies sent to and enter a new address or click on Select Names… to search your Address Book for the address.

By default, Outlook saves a copy of messages you send to a folder labeled Sent items. If you would like this message stored in another location, check the box labeled Save sent message to and click on the Browse… button to locate the folder in which the sent message should be stored.

Click on the down arrow beside the box labeled Do not deliver before to specify a date and time after which the message may be delivered. Click on the down arrow beside the box labeled Expires after to specify a date and time after which the message will be unavailable.

Click on this button to have the message associated (linked) with a contact or group of contacts within your Address book.
Click on this button to assign the current message to a category which is used by Outlook to group like-messages. Once categorized, you can search for messages based on their category.

Check the box to the left of the desired category name. The category will be added to the top section of the dialog box. You can check more than one category.

To create a new category, simply enter the new category name in the top section of the dialog box and click on [Add to List].

If you wish to remove an existing category from the main list, click on [Master Category List...] which will take you to a new dialog box containing a list of existing categories. Select the category to be removed and click on [Delete]. Once deleted, click on [OK] to return to the previous dialog box.

When done categorizing your message, click on [OK]. You will be returned to the original “Message Options” dialog box.

Click on [Close] to return to your message and close this box.
USING THE SPELL CHECKER

Before sending a message out, you should always spell check it for typing errors. By comparing words in your message against the dictionary, Outlook can check your spelling and alert you of possible mistakes.

For each word that the program cannot find in its dictionary, Outlook asks what you want to do. You can choose to do any of the following: Change the spelling of the word, suggest alternative words, leave the word as it is, or add the word to the dictionary. Outlook also checks for words that are incorrectly capitalized and for repeated words.

Outlook will stop at the first unrecognized word, highlight it, display it in the dialog box along with a list of options.

If, for some reason, Outlook does not offer suggestions, click on the button. If you still do not receive alternative suggestions, Outlook cannot find any words it feels is close to the misspelling. If this occurs, you can enter the correction yourself in the box labeled Change to:
The following buttons are provided within the spell checking box:

**Ignore**
- If the word should remain as it is, select the **Ignore** button. Outlook also offers the option of **Ignore All** if the word in question appears throughout the message.

**Change**
- If one of the suggestions is correct, double-click on the correct spelling or highlight the word and choose the **Change** button. If you are afraid you misspelled a word more than once, click on the **Change All** button.

- If both the word and suggestions are incorrect, you can type the correct spelling in yourself since your cursor is already blinking in the top section (beside the selected word). When done, press **Enter** or select **Change**.

**Add**
- If the word should be added to the custom dictionary for future reference, click on this button. This is useful for adding company acronyms or special terms used in your organization.

**Undo Last**
- This button reverses the last change made during the current spell checking session.
Microsoft Outlook 2003 IMAP Email Guide

Click on this button to change some of the options.

The section labeled **General options** contains several items. The first allows you to determine whether suggestions should be offered. The second box specifies whether to spell check each message before sending it out. The next three checkboxes allow you to specify what types of words to ignore during the spell check (i.e., uppercase words, words containing numbers, and the original text if replying to or forwarding a message). The last checkbox and button allow you to enable and set AutoCorrect options.

The section labeled **Edit custom dictionary** allows you to add, change, or remove words that you may have added to your personal dictionary.

The section labeled **International dictionaries** allows you to specify the language to be used when spell checking messages.

Once all options are selected, choose **OK**. You will be returned to the original spell checking dialog box.
DELIVERING/RECEIVING MESSAGES

USAGE:

Once you have typed the message, send it. Depending on your settings, Outlook may temporarily store your outgoing messages in the Outbox folder until you choose to manually deliver them.

![Send button]

Click on the **Send** button.

The New Message window will close and the message will be placed in your Outbox folder. Depending on the type of messaging service you are using (Internet Mail vs. MS Exchange) and the type of connection you have, the delivery and receipt of messages may differ slightly.

Once you are back in the Inbox and are ready to deliver the message(s) and receive any new incoming messages, click on the **Send/Receive** button.

If you have more than one mail account and want to check messages for a specific account, access the following menu:

![Tools menu]

Select the account whose mail you want to send/receive.
IDENTIFYING UNREAD MESSAGES

Once your mail has been delivered to the Inbox, you will be able to read it. The number of unread messages within a folder appears next to the folder name enclosed in parentheses.

Not only will the Inbox display the number of unread messages but a separate folder labeled **Unread Mail** will be created.

Unread messages are displayed in bold, as shown below:

You may either highlight the message and then view the actual message contents (in the reading pane) or double-click on the message to open it in a separate window.

To change the width of one of the columns within the Inbox, follow the steps outlined below:

1. Move the mouse to the right of the column header you want to adjust. The mouse pointer will change to the shape of a double-sided arrow.
2. Begin dragging the mouse to adjust the column width.
3. When done, release the mouse button.
SORTING MESSAGES

To quickly sort the messages by any one of the columns, simply click on the desired column heading and the messages will be sorted in that order. A small triangle is displayed in the currently sorted column. By default, the From and Subject columns are sorted in ascending sequence (A-Z) while the Received column is sorted in descending order.

There may be times when working with Outlook that you will need to reverse the order of the sort.

You can quickly switch the sort order by clicking the column heading a second time.

You can also sort a column by following the steps shown below:

1. Point to the column heading to be sorted and click the [RIGHT] mouse button once.

2. Select the desired sort order from the top of the pop-up menu.
FINDING MESSAGES

If you would like to locate a message you have stored within Outlook, you can use the Find feature to quickly search a single folder or all of your folders.

To find a message, follow these steps:

1. Click on this tool (located on the standard tool bar towards the top of the screen).

   A new bar will be placed on your screen - along the top line of the Inbox, as shown below:

   ![Find tool](image)

2. Click in this box and enter a name or the keywords/text you are searching for. Click on the down arrow beside this box to select from a list of previously entered keywords.

3. Click on the down arrow beside this button to specify what folder(s) to search.

   (OPTIONAL)

4. Click on the down arrow beside this button to specify any advanced options.

5. Click on this button to begin the search.
Once the search has been completed, Outlook will display the headers of the messages that match your search criteria.

CANCELING A SEARCH

If you have a lot of messages and the search is taking too long, click on **Stop** to cancel it.

CLEARING THE SEARCH RESULTS

If you want to begin a new search or simply wish to display all of your original messages again, click on **Clear**.
READING MESSAGES

Usage:

Outlook places all new mail in your Inbox. Like reading physical mail, you will probably check and read new mail on a daily basis. Depending on the mailing lists you subscribe to, you may find yourself spending quite a bit of time reading and sorting through your mail. Knowing how to effectively read and then filter your mail can be quite a time saver.

Messages stored in your Inbox appear in AutoPreview which allows you to read the first few lines of each message. If you do not see the preview, access the View → AutoPreview menu.

In addition, you can read mail directly from the Inbox by highlighting the message and reading the contents in the preview pane. If you do not see the preview, access the View → Reading Pane menu and then choose where you want the reading pane to be placed.

If a message is quite long, you may want to open it in a separate window by double-clicking on the message.

Once opened, the following tools are available:

- Click on this tool to read the previous message. If you click on the down arrow to the right of this tool, you can choose the type of messages to display (e.g., those marked as high importance, flagged, unread).

- Click on this tool to read the next message. If you click on the down arrow to the right of this tool, you can choose the type of messages to display (e.g., those marked as high importance, flagged, unread).

- Click on this button to delete the current message and display the next message in the list.

- Click on this button in the upper right corner of the message window to close the current message.

When you exit the message screen, you will see the messages that have been read will no longer be displayed in bold.
MARKING MESSAGES AS BEING READ/UNREAD

Once a message has been marked as being read, you may decide to mark the message as **Unread** as a possible reminder for reviewing the message again at a later time. Alternatively, you may wish to mark a newly received message as having been **read** if you feel that it contains information of no interest to you.

MARKING/UNMARKING MESSAGES

To mark an unread message as being read or unmark a read message as not having been read, either access the **Edit** menu or follow the steps shown below:

1. From the Inbox, point to the message to be marked as read or unread and click the [RIGHT] mouse button once.

2. Select **Mark as Unread** or **Mark as Read** from the pop-up menu.
DELETING MESSAGES

USAGE:

Once a message has been read, you may want to remove it permanently from your Inbox. If you are using Outlook with Princeton's IMAP server, you will first mark the message for deletion, and then purge the message to permanently remove it.

To mark a single message for deletion, simply click on the message once and click on the tool or press the key.

MARKING MULTIPLE MESSAGES FOR DELETION

To mark multiple unwanted messages for deletion, select the messages you wish to remove - using one of the methods shown below:

Selecting Contiguous Messages

1. Select the first message.
2. While holding down the key, click once on the last message to be selected. All messages between the first and last should now be selected.

Selecting Noncontiguous Messages

1. Select the first message.
2. Hold down and click on each message to be included.

Once the messages are selected (using one the methods shown above), click on from the toolbar or press the key once.
DELETING ITEMS FROM YOUR IMAP FOLDERS

When you delete an item from an IMAP folder such as your Inbox, folder, the item is marked for deletion. Marking for deletion places a line though the item in the mail list and displays it in a gray font color. While marked for deletion, it is still in the folder, and still taking up space. In order to permanently remove the items from an IMAP folder, you must purge the items.

PURGING DELETED ITEMS

To purge the deleted items from an IMAP folder,

1. Choose Edit, Purge Deleted Messages from the menu.

2. A message box is displayed asking you to confirm the purge.

3. Click the YES button to complete the purge. These items are now permanently deleted; they can not be recovered.
MANAGING DELETED ITEMS IN IMAP FOLDER VIEWS

Immediately purge items every time you delete something from an IMAP folder is not necessary. It is usually easier to purge your deleted items periodically, say one a day or even once a week if you do not receive a large volume of mail. If you choose to purge periodically, the items that are marked for deletion will continue to be displayed in your view of the folder contents until you do so.

This can be distracting when you are trying to work with the active items on the list. Fortunately, you can use one of two filters to control how items marked for deletion are handled. Both filters are located on the Current Views List, which is located on the Advanced Toolbar.
HIDING DELETED ITEMS

This filter will hide items that are marked for deletion. As soon as you delete an item, it will disappear from the list. It is important to remember that even though the item has disappeared, it is still in your folder, and still taking up space, until you purge the folder.
GROUPING DELETED ITEMS

This filter will group items that are marked for deletion and displayed that group at the bottom of the list of items. As soon as you delete an item, it will be moved into the deleted group. It is important to remember that the item is still in your folder, and still taking up space, until you purge the folder.
DELETING ITEMS FROM YOUR PERSONAL FOLDERS

When you delete an item from a personal folder in Outlook, the item is removed from that folder and placed in the Deleted Items folder. You should periodically “take out the trash” by emptying the Deleted Items Folder.

Follow the steps outlined below to empty the trash:

1. While pointing to the “Deleted Items” folder, click your [RIGHT] mouse button once.

2. Select **Empty “Deleted Items” Folder**.

   You will be asked to confirm the deletion:

   ![Confirmation dialog](image)
   
   **Are you sure you want to permanently delete all the items and subfolders in the “Deleted Items” folder?**

   [Yes] [No]

3. Click on **Yes** to confirm the deletion.
PRINTING A MESSAGE

After reading a message, you may decide it should be printed.

1. Select the message(s) to print from the Inbox.
2. If you want to print the selected message(s) immediately to your default printer, click on  .

To switch printers or change printing options, access the menu:

Select the name of the printer you wish to use and then change any of its Properties. To send the printout to a special file for printing later, check the box labeled Print to file.

Select the Print style to be used (e.g., table, memo). There are buttons to specify page setup and styles. You can also set the number of copies. Lastly, you may specify if each message should be printed on a separate page and if attachments will be included.

When done, choose OK.
REPLYING TO A MESSAGE

USAGE:

While viewing a message, you may decide it requires a reply on your part. Outlook offers an easy method for replying to messages as you view them. When you reply to a message, Outlook automatically addresses the reply to the original sender of the message.

You will have the choice of either replying to the original sender of the message or to everyone who received a copy of the message.

1. Select or open the message you wish to reply to.

2. Click on one of the Reply buttons. The button on the top replies only to the sender while the bottom button replies to all recipients.

3. Outlook will automatically create a new message with the addressee and subject already entered.

4. Enter your reply above the quoted text (the dashed line).

5. When done, click on the Send button.

-----Original Message-----
From: Henry
Sent: Monday, February 27, 2003 12:32 PM
To: Kimberley
Subject: Latest Course Listing
FORWARDING A MESSAGE

USAGE: Once you view a message, you may determine that it needs to be forwarded to someone else.

Follow the steps outlined below to forward a message:

1. Select or view the message you wish to forward.

2. Click on the **Forward** button once.

3. Outlook will automatically create a new message with the subject already entered. The original message will be an attachment. You will need to enter a **To:** address - indicating who you are forwarding it to.

4. Enter a short explanation in the window provided as to why you are forwarding the message.

4. When done, click on the **Send** button.

---

George:

I think this was meant for you!

--- Original Message ---

From: Henry
Sent: Monday, February 27, 2003 12:32 PM
To: Kimberly
Subject: Latest Course Listing
WORKING WITH ATTACHMENTS

USAGE:

There may be times when a message alone is not enough. You may need to attach a word processing or spreadsheet file to the message so that you can reference a point within the file or ask someone to update a file which you have started. This allows the recipient to view and modify (if necessary) complex documents.

ATTACHING A FILE TO A MESSAGE

To attach a document to a message, follow the steps below:

1. Access the New Message window and then select the Attach tool (you may need to click on first to find this tool).

The following dialog box will be displayed:

Along the left side of the dialog box, Outlook displays the Places Bar which includes My Recent Documents, Desktop, My Documents, My Computer, and My Network Places. These "places" can be used to quickly access specific types of documents or storage locations. The icons along the left side may appear a bit different - depending on the operating system you are running.
If you do not store your documents in one of these locations, you will need to switch to a different folder by clicking on the down arrow beside the box labeled Look in (located across the top of the dialog box) and select the location you want to display.

Across the top of the dialog box are a series of buttons, as described below:

- Click on this tool to display previously visited folders.
- This tool moves up one folder level at a time.
- Click on this tool to search the Web for a storage location.
- This button is used to delete an existing file.
- Use this tool to create a new folder.
- Click on the down arrow beside this button to select the type of view to use for displaying the documents.
- Use this tool to access a pull-down menu for advanced options (such as finding, deleting, renaming files and mapping network drives).

You can click in the File name box to manually enter the name of the file to be attached to this message.

Click on the down arrow beside the Files of type box to select the type of files to list. Use this to narrow the list of displayed files.

Select the file(s) to be attached and choose Insert.
SAVING AN ATTACHMENT

If you receive a message containing an attachment, you will see a paperclip on the left side of the message within the Inbox. However, be wary of messages with attachments from unknown sources, as they may contain computer viruses.

To save the attachment for future use, access the following menu:

**File**
**Save Attachments**

From the list of available attachments, select the one to be saved. You will be taken to the standard “Save” dialog box where you can specify the drive/folder in which the file should be stored.

OPENING AN ATTACHMENT

While you are reading a message which contains an attachment, you should see an icon (as shown in the examples below) - representing the type of attached file:

**Attachments:**  
Right-Click on the attachment icon and choose Open to access the attached file.

The example shown above represents a Word document that has been attached to the message.

Once you open the attachment in its application, you can save it as you would any other file from within the program.
CUSTOMIZING THE VIEW

USAGE:

There are a number of views available within Outlook. For example, you can choose to display all of your messages, those that have been received within the last 7 days, or only your unread messages.

To switch the current view, access the following menu:

From the list of available views, select the one you want to display.
Select **Customize Current View**… from the sub-menu to customize the current view. You will be taken to a dialog box where you will be able to define which fields you want to view, determine a grouping order for the messages (if any), how your messages should be sorted, and the format to be applied.

Notice you can also create a new view from scratch by selecting **Define Views**… from the sub-menu. You will be taken to a dialog box where the you will be able to modify one of the current views, rename or delete an existing view or create a new one.

If you choose **Format Columns**… from the sub-menu, you will be taken to a dialog box where you can create new column labels, as well as adjust the width and the alignment of the columns.
STORING MESSAGES

 USAGE: The amount of space that you have on the IMAP mail server is limited. You may want to retain a message for future use but do not want it to remain in your IMAP Inbox. If you are also keeping your Sent Items on the server, you may wish to file some of those items into a personal folder as well. Filing messages into a personal folder frees up space for new incoming mail.

Folders are also used as a means of organizing messages. Outlook comes with four predefined e-mail folders: Inbox, Outbox, Sent Items and Drafts. You may create additional server folders or personal folders to store and organize messages in a way that works for you.

CREATING FOLDERS

Although you could access the File ➔ Folder ➔ New Folder menu, it is faster to use the mouse, as shown in the steps below:

1. Click on the down arrow beside this button and select Folder... from the list. If you don’t see the “Folder...” option, you will need to click on to access the full set of menu items. The new folder dialog box will be displayed.
Creating a New Personal Folder

Enter a **Name** for the new folder in the box provided.

Click on the down arrow beside the **Folder contains** section to specify what type of objects the new folder will hold (e.g., Mail and Post Items, Notes, Tasks). In this case, be sure to select **Mail and Post Items**.

Select **Personal Folders** as the location under which this new folder will be stored.

Once you have named the new folder, specified what it will contain and selected where it should be placed, click **OK**.

Creating a New IMAP Folder

Enter a **Name** for the new folder in the box provided.

Click on the down arrow beside the **Folder contains** section to specify what type of objects the new folder will hold (e.g., Mail and Post Items, Notes, Tasks). In this case, be sure to select **Mail and Post Items**.

Select **imap.princeton.edu** as the location under which this new folder will be stored.

Once you have named the new folder, specified what it will contain and selected where it should be placed, click **OK**.
MOVING A MESSAGE

Once you have created a folder, you are ready to actually store messages in the folder. Follow these steps to file messages:

1. Select the message(s) you want to store.
2. Drag the selected message(s) to the desired folder on the Navigation Bar.

Note: If you move a message from an IMAP folder, the message is marked for deletion in that folder, and a copy is placed in the folder to which you are moving it. You will need to purge the message from the original folder as you would with a deleted message. (see Purging Deleted Items)

RENAMEING A FOLDER

If you created a folder but now want to change its name, follow the steps outlined below:

1. Click once on the folder to be renamed - to select it.
2. Click a second time (slowly) to edit the folder's name. When you see the cursor blinking, you may begin editing.
3. When done, press [ENTER] or click away.

TIP: You can also use the Folder List to organize messages by dragging items on top of folder names.
DELETING A FOLDER

To delete a folder, follow the steps outlined below:

1. Select the folder from the Navigation Bar.

2. Press the `DEL` key.

3. You will be asked to confirm the deletion of the folder and all of its contents.
WORKING WITH A CONTACT LIST

USAGE:

Outlook allows you to easily create, store, organize and retrieve names, addresses and phone numbers of contacts for both personal and business needs.

You can organize your contact list within Outlook by sorting the data on up to three fields (e.g., first by company, then by department and finally by title). Outlook also allows you to quickly create mailing labels for your contact list and schedule appointments/meetings with anyone on the list.

Click on this button (located on the Outlook Bar) to view the Contacts list.

The diagram shown below illustrates an existing contact list:
ADDING A CONTACT

Click on this button to add a contact to the list. A dialog box will appear for you to enter the data for the new contact, as shown below:

The first tab (labeled General) should be selected. It is divided into several sections, as outlined below:

- **Full Name...**
  - Use this box to enter the full name of the new contact. If you click on the button, it will display another dialog box which breaks the name down by fields (e.g., first name, last name). These fields can be used for correctly identifying parts of a name for future sorting.

- **Job title**
  - Use this box to enter the position or job title of the new contact.

- **Company**
  - Enter the name of the organization where the new contact is employed.
<table>
<thead>
<tr>
<th><strong>File as</strong></th>
<th>Use this box to create a variation of the contact’s name and business which can then be used to better organize your list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phone</strong></td>
<td>Use these four boxes to enter business and personal phone, fax, and mobile numbers for the new contact.</td>
</tr>
<tr>
<td></td>
<td>Enter the new contact’s mail address in the box provided. If you click on the button, it will display another dialog box which breaks the address down by fields (e.g., street, city, state). These fields are used for identifying parts of an address for future sorting.</td>
</tr>
<tr>
<td></td>
<td>There is a checkbox for identifying whether this is a mailing address for the new contact.</td>
</tr>
<tr>
<td><strong>E-mail</strong></td>
<td>Enter the new contact’s e-mail address. Notice there is a box for instructing Outlook how to display the contact’s name.</td>
</tr>
<tr>
<td><strong>Web page</strong></td>
<td>Enter the new contact’s Web page address and IM (Instant Messaging) address.</td>
</tr>
<tr>
<td></td>
<td>Click on this button to associate/link this contact with another from your Address Book.</td>
</tr>
<tr>
<td></td>
<td>Click on this button to enter the category for the new contact (e.g., business, personal). This category can be used later to group the contacts within your list.</td>
</tr>
<tr>
<td><strong>Private</strong></td>
<td>Check this box to keep the contact hidden from other users.</td>
</tr>
</tbody>
</table>
The second tab (labeled **Details**) allows you to enter more detailed information regarding the contact’s business and personal data:

<table>
<thead>
<tr>
<th>General</th>
<th>Details</th>
<th>Activities</th>
<th>Certificates</th>
<th>All Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department:</td>
<td>Manager’s name:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Office:</td>
<td>Assistant’s name:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profession:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Nickname: | Spouse’s name: | |
| Title: | Birthday: | None |
| Suffix: | Anniversary: | None |

**Online NetMeeting settings:**
- Directory server:
- E-mail alias:
- Call Now:

**Internet Free-Busy**
- Address:

The top portion of the dialog box contains sections which can be used to enter such detailed information as the contact’s department, office, profession, title, nickname, and spouse’s name.

The bottom of the dialog box contains two additional sections:

**Online NetMeeting settings**
Enter the directory server and e-mail alias for setting up a conference via NetMeeting. Click on **Call Now** to start an online meeting.

**Internet Free-Busy**
Enter the server where your contact’s free/busy information is stored.
The third tab (labeled **Activities**) displays any items (such as messages, tasks, and meetings) that are linked/associated with this new contact, as illustrated below:

Since this is a new contact, however, there won’t be any items associated with it yet. As you send messages, meeting requests, and other items to this contact, you can use this tab in the future to review the links.

**Show all**  
Click on the down arrow ⬇️ beside this option to select the type of items you would like to see.

As you access this tab, Outlook will begin searching for any links that may be associated with the current contact. If you have a large database and wish to only search for certain items, you may want to click on this button to stop the current search and then select the “Show” section to specify exactly which items should be displayed.
The fourth tab (labeled **Certificates**) allows you to add a certificate (digital ID) for the new contact. This certificate can be used to send secure, encrypted e-mail to this contact. To get a certificate from a contact, the contact must have sent you a digitally signed e-mail message or a certificate file.

<table>
<thead>
<tr>
<th>General</th>
<th>Details</th>
<th>Activities</th>
<th>Certificates</th>
<th>All Fields</th>
</tr>
</thead>
</table>

Outlook will use one of these certificates to send encrypted mail to this contact. You can get a certificate by receiving digitally signed mail from this contact or by importing a certificate file for this contact.

**Certificates (Digital IDs):**

- **Properties...**
- **Set as Default**
- **Import...**
- **Export...**
- **Remove**

**Certificates**

Lists certificates associated with the contact.

Click on this button to view properties (details) of the selected certificate. Properties include information as to who issued the certificate and when the certificate expires.

Click on this button to set the certificate as the default for sending secured documents to this contact. This is only available when the contact has more than one certificate.

Click on this button to import a certificate file for this contact.

Click on this button to export a certificate file for this contact.

Click on this button to remove the certificate associated with this contact.
The fifth tab (labeled **All Fields**) allows you to view fields in a table format and add/customize/delete your own fields.

**Select from**

- Use this section to view specific groups of fields in a tabular format.
- Click on this button to create a custom field.
- Click on this button to customize the properties of a field you created.
- Click on this button to delete the currently selected field. You can only delete fields you have created.

1. Enter the information for the new contact in the five tabbed boxes displayed on this and the previous pages.

2. When done, choose ![Save and Close](image) to return to the Contact view or click on ![Save and Close](image) to save this contact and add another.
ORGANIZING THE CONTACT LIST

Once you have created your contact list, you may decide that you would like to view those contacts whose name begins with a specific letter. Like a filofax, you can quickly flip to a specific letter by clicking on the letter from the list provided on the right side of the Contacts window.

Click on the letter to display (from the far right side of the Contacts window).

The letters will be grouped depending on the size of your window. For example, if the window is maximized, each letter will appear alone down the list while a smaller window will group two letters together (as illustrated in this diagram).

The list will scroll up or down so that contacts whose names start with the letter specified will be displayed.

WIDENING COLUMNS

You may want to adjust the size of the columns within the Contacts window to display more or fewer contacts. To do so, follow the steps shown below:

1. Place the mouse pointer along the right margin of one of the columns. Make sure the pointer is on the column margin line. The pointer changes to a double-sided arrow indicating you are on the margin line.

2. Click and drag the column margin either to the right (to display fewer contacts) or to the left (to display more contacts). When you release the mouse button the columns will adjust to their new size.
SORTING CONTACTS

The Contacts list may be easier to read if you sort the list by one of the fields (e.g., last name, company).

1. Switch to one of the columnar list views by accessing this list (which is located along the left side of the window on the Outlook Navigation Bar).

2. Click on the column title you want to sort. Click a second time to reverse the sort order.

3. To sort on more than one column, follow these steps:
   - Click the [RIGHT] mouse button while pointing to the blank Contact line at the top of the list (which is directly beneath the column titles).

4. Choose Sort.. from the pop-up menu that appears.
The following dialog box will be displayed:

Select up to four fields (columns) to sort and whether each field should be sorted in ascending or descending order.

To select from a different group, click on the down arrow beside the field list at the bottom of the dialog box.

When done, click OK.
GROUPING CONTACTS

Like tasks, Outlook allows you to organize your contacts in an outline format. Outlook provides four predefined group views that are prefixed with the word “By”. You can quickly organize your contacts based on one of these group views or define your own groups by following the steps outlined below:

1. Click on the down arrow beside this box (located on the Outlook Navigation Bar). Select any tabular list (e.g., phone list).

2. Click on this tool. A new section (referred to as the Group By Box) will appear between the folder banner and the column headings.

3. Click on the column header to be used for the grouping and drag it to the group box.

TIP: If you click on a group header, you can reverse the sort order of the group.
COLLAPSING AND EXPANDING GROUPS

Once you have grouped your contacts, you can collapse them so that only the group name is listed but not the actual details or expand them so that both the name and their details are displayed.

- To collapse a level and hide its details, click this button.
+ Click this button to expand the level, showing its details.

DELETING A CONTACT

If you decide you no longer want one of the contacts in your list, you can quickly remove it by following the steps shown below:

1. Select the contact to be removed.
2. Click on the button, located on the toolbar.

UNDELETING A CONTACT

If you delete the wrong contact or decide for any reason that you need the contact back, Outlook allows you to undo your last action - which could be deleting a contact.

Although you could access the Edit → Undo menu, it is easier to use your mouse, as shown below:

Click on (which is located on the Advanced tool bar) to undo the last action.

NOTE: Be careful! Only the last action can be undone. If you delete a contact and then continue creating new contacts or editing existing ones, you will be unable to undo the deletion!
CREATING SUB-GROUPS

If you have many contacts and wish to group them according to multiple criteria, you can easily break down the main group into one or more sub-groups. For example, if you decide to first group your contacts based on their company name, you could then break down each company group further by the full name of the contacts.

To add a sub-group, simply drag a second column header and place it to the right of the main group.

Outlook will show the relationship between the groups, as shown in the diagram below:

```
Company    Full Name
```

**TIP:** If you click on a group or sub-group header, you can reverse the sort order of the group.

**NOTE:** To permanently remove a sub-group, drag it out of the Group By box.
SENDING CONTACT INFORMATION VIA E-MAIL

If you want to send contact information from someone in your contact list or your own contact information to another user, you can forward the information as a vCard. A vCard is an Internet standard file for creating and sharing virtual business cards.

You can send contact information as a vCard or save vCards sent to you via e-mail.

To send a vCard to another user, follow the steps outlined below:

1. Select the name of the contact whose information you want to forward from your Contacts folder.

2. Access the following menu:

   **Actions**
   
   **Forward as vCard**

   A new message will be created with the contact information attached to the message.

   An icon will be placed along the bottom of the message box to represent the vCard.

3. Enter any accompanying message text you would like to send along with the vCard.

4. When done, click on **Send** to send the message.
SAVING A VCARD

If someone sends you a vCard through an e-mail message, you can easily save the vCard as a new contact. All of the information (such as name, address, and telephone number) stored in the vCard will automatically be saved in the appropriate fields in your Contacts folder.

To save a vCard that has been received via an e-mail message, follow the steps outlined below:

1. Open the message containing the vCard.
2. While pointing to the vCard attachment, click the [RIGHT] mouse button once.
3. From the pop-up menu that appears, choose Open.

If you receive a message warning about mail attachments and are given the choice to open the attachment or save it to disk, be sure to choose "Open".

Outlook will automatically create and open a Contact Entry for the information stored on the vCard.

You can edit the information as desired.

4. When done, click on [Save and Close].

Your Contacts folder should now contain a new entry with all of the information stored on the vCard you received.
CREATING A MAILING LIST

If you would like to create a mailing list consisting of multiple addresses for sending messages to a group of users in the future, you may do so by following the steps outlined below:

1. From within the Address Book, click on this button to create a new mailing list.

   The following dialog box will be displayed:

   ![Dialog Box]

2. Select **New Distribution List** as the type of new entry.

3. When done, click on **OK**.
The “Distribution List” dialog box is displayed, as shown below:

1. Enter a name for the new list in the box provided.
2. Click on Select Members... From the resulting dialog box, you can either type the name of the member you would like to add to the new mailing list or select it from the list that is provided along the left side of the box, as shown below.
6. If you have more than one address book/list, click on the down arrow beside the box labeled **Show Names from the** to select the list from which you want to choose the members for this distribution list.

7. Enter the name in the box provided or double-click on a name (from the left side of the dialog box) to add it to the new mailing list.

   If you would like to add several names, you can use the **SHIFT** key (to select contiguous names) or the **CTRL** key (to select noncontiguous names).

   After selecting the desired name(s), click on Members -> which copies the selected name(s) to the right side of the dialog box (labeled **Add to distribution list**).

8. When done adding members, choose OK to return to the “Distribution List” dialog box.

9. Once you are back in the “Distribution List” dialog box, you can select the tab labeled **Notes** (which is located across the top of the dialog box) to add a description or comments to the new distribution list.

10. When done, click on Save and Close to save the new list and close this dialog box.

   This new distribution list can now be used as an addressee for your messages. Outlook will send the same message to all of the members of the list.
REMOVING A MEMBER FROM THE LIST

To remove a member from a list, follow the steps outlined below:

1. From the Address Book window, double-click on the name of the list you wish to modify. The properties for the selected group will be displayed, as illustrated below:

   ![Address Book Window](image)

   - **Members** column: Names of members
   - **Notes** column: Additional information
   - **Select Members** button
   - **Add New** button
   - **Remove** button
   - **Update Now** button

2. Select the member(s) to be removed and click on the **Remove** button.

   **NOTE:** Be sure you want to remove the member. You will not be asked to confirm the deletion!

3. When done, click on **Save and Close**.

CLOSING THE ADDRESS BOOK WINDOW

When you are done working with the Address Book, close it by clicking on the close button (which is located in the upper right corner of the Address Book window).
CHANGING OUTLOOK OPTIONS

Usage:

Outlook allows you to customize such options as how mail is handled and the default settings for tasks or appointments. You can also customize security settings such as how certificates are issued and whether e-mail messages should be encrypted.

Menu:

Tools
Options...

Setting Preferences

The first tab displayed is labeled Preferences and allows you to edit your e-mail, calendar, tasks, contacts and notes settings:

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Mail Setup</th>
<th>Mail Format</th>
<th>Spelling</th>
<th>Security</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail</td>
<td>Change the appearance of messages and the way they are handled.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Junk E-mail...</td>
<td>E-mail Options...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calendar</td>
<td>Customize the appearance of the Calendar.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default reminder: 15 minutes</td>
<td>Calendar Options...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tasks</td>
<td>Change the appearance of tasks.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminder time: 8:00 AM</td>
<td>Task Options...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contacts</td>
<td>Change default settings for contact and journal.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contact Options...</td>
<td>Journal Options...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Change the appearance of notes.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note Options...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The first tab (labeled **Options**) is used to set your junk mail protection level. You can choose to exclude all automatic filters but send any message received from a user within the “Blocked Senders” section to the Junk E-mail folder. If you choose “Low” Outlook will send any obvious junk to the appropriate folder. Selecting “High” will remove most junk mail from your Inbox but may also include a regular message so you will need to check your Junk E-mail folder occasionally to be sure it does not include any important messages. If you choose “Safe Lists Only”, Outlook will only display those messages received from people or domains contained within your defined safe lists in your Inbox.

The checkbox at the bottom of this dialog box is used to permanently delete junk mail instead of moving it to the Junk E-mail folder.

The other three tabs are used to add safe senders, safe recipients, and blocked senders to your list.

When done, click on **OK** to return to the original box.
Message handling

This section instructs Outlook what to do after you move or delete an opened mail item. You can choose to close a message that has been forwarded or replied to, to save copies of all messages you send in your Sent Items folder, save unsent messages for later use, remove extra line breaks in plain text messages, and read all standard mail in plain text format. Advanced e-mail options include specifying how to be notified of new messages and default importance levels. Tracking options include verifying the date and time messages are received and how to respond to requests for read receipts.

On replies and forwards

This section specifies if and how the original message should be included when replying or forwarding.

When done, click on OK to return to the original box.
Click on this button to define how contact names should be displayed and filed.

The following options are available within this dialog box:

**Default “Full Name” order**  
Click on the down arrow to specify the default name format to be used for new contacts.

**Default “File As” order**  
Click on the down arrow to specify the default file format to be used for new contacts.

There is also a checkbox within this dialog box to instruct Outlook to look for duplicate names when adding a new contact. This can save you from accidentally adding the same contact twice.

**Contacts Index options**  
Use this section to show an additional index and specify in what language.

When done, click **OK** to return to the original dialog box.
Click on this button to edit the journal options.

Automatically record items: Specify the type of item(s) to record for Journal entries. Check as many boxes as desired.

For these contacts: Specify which contact(s) should be included in the automatic Journal entries.

Also record files from: Creates a Journal entry with the date and time when you create, open, close or save any file in the specified application.

Double-clicking on entry: Select what action double-clicking on an entry will have.

Click this button to specify when to move Journal entries to an archive file or whether to delete them after a specified time.

When done, click on OK to return to the original box.
Click on this button to change the color, size, font and point size assigned to notes that you create within Outlook.

The following dialog box will be displayed:

![Dialog Box]

While in this dialog box, you may assign a new color, size, font and point size to new notes.

When done, click on **OK** to return to the original “Options” dialog box.
MAIL SETUP

The second tab is used to define your mail profile and to specify when Outlook should connect to your dial-up accounts.

### Preferences
- **Mail Setup**
  - **E-mail Accounts**
    - Set up e-mail accounts and directories.
    - **E-mail Accounts…**
  - **Send/Receive**
    - Set send and receive settings for e-mail messages and documents.
    - **Send/Receive…**
  - **Data Files**
    - Change settings for the files Outlook uses to store e-mail messages and documents.
    - **Data Files…**
  - **Dial-up**
    - Control how Outlook connects to your dial-up accounts.
    - Warn before switching an existing dial-up connection
    - Always use an existing dial-up connection
    - Automatically dial during a background Send/Receive
    - Hang up when finished with a manual Send/Receive

### E-mail Accounts
Use this section to add or modify an existing e-mail address and/or Address Book.

### Send/Receive
Use this section to specify how often to check for e-mail when Outlook is online/offline.

### Data Files
This section allows you to add, modify, or remove the data files associated with Outlook.

### Dial-up
Use these checkboxes to specify how Outlook connects to your dial-up accounts.

When done, click on **OK** to return to the original “Options” dialog box.
MAIL FORMAT OPTIONS

The third tab allows you to specify the format to be used when creating messages and to determine if a signature file should automatically be attached to all of your messages.

Message format

Use this section to specify the format to be used for your messages when sending outgoing mail. Select the most appropriate format for the majority of your addressees.

For example, if most of your mail recipients can read mail in HTML format, select this option. If you are unsure, you should choose Plain Text to be certain everyone can read your e-mail.
### Message format (Continued)
If you are using a foreign language version of Outlook, click on **International Options...** to display field labels, such as From, Sent, To, and Subject in English when replying to or forwarding messages.

### Stationery and Fonts
If you selected HTML as your message format, you can further customize your messages by using a built-in stationery or by assigning a new font, point size and color.

Click on **Fonts...** to access a second dialog box where you may choose the fonts and attributes to be applied when composing new messages, replying/forwarding, or when composing/reading plain text messages.

Click on **Stationery Picker...** to access a second dialog box where you can preview the available stationery formats. You may edit, remove, or add new stationery as needed.

### Signature
If you would like Outlook to automatically add a signature block to the end of each message you create, use this option to specify what text file to use. Click on **Signatures...** to access a dialog box where you can preview, edit, remove, or add new signature files.

When done, click on **OK** to return to the original “Options” dialog box.
SPELLING OPTIONS

The fourth tab allows you to specify the spelling options to apply when checking your messages for mistakes.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Mail Setup</th>
<th>Mail Format</th>
<th>Spelling</th>
<th>Security</th>
<th>Other</th>
</tr>
</thead>
</table>

### General options
- **Check spelling before sending**
- **Ignore words in UPPERCASE**
- **Ignore words with numbers**
- **Ignore original message text in reply or forward**
- **Use AutoCorrect when Word isn't the e-mail editor**

### Edit custom dictionary
- Add, change, or remove words from your custom dictionary.

### International dictionaries
- Choose which dictionary to use when checking your spelling.
  - **Language:** English (U.S.)

**General options**
Use this section to set such options as when to check messages for errors and which types of words (those in uppercase and/or those with numbers) to ignore during the checking process. You can also choose to ignore original message text when replying/forwarding.

**Edit custom dictionary**
If you have added words to your custom dictionary, use this section to edit or remove those words.

**International dictionaries**
Use this section to specify the language to use when spell checking.
The sixth tab allows you to set miscellaneous options, such as whether the Deleted items folder should be emptied when you exit the application, when to archive your old items and how to display the preview pane.

**General**

- Check the box labeled **Empty the Deleted Items folder upon exiting** to have Outlook remove the contents of the folder each time you exit the program. If you check this box you will need to be careful what items you place in the Deleted Items folder as it will be permanently cleared out each time you close the application.

The second checkbox is used to set Outlook as your default e-mail, contacts and calendar program.
General (Continued)

Click on **Navigation Pane Options...** to specify
which buttons and in what order to display
them in the navigation pane (down the left side
of the Outlook window).

Click on **Advanced Options...** to set more
advanced options.

AutoArchive

Click on **AutoArchive...** to archive old items.
The dialog box that will be displayed when you
click on this button is used to specify how often
to archive, whether to be prompted before
archiving and whether archived messages are
to be deleted. You can also set the default
archive file.

Reading Pane

Click on the **Reading Pane...** button to access
a second dialog box where you may specify
how to display the preview pane.

Person Names

Check the top box in this section to enable the
Person Names smart tag. Check the bottom
box in this section to specify the names listed
in the From field display Instant Message
status.

Once all settings have been modified, click on **OK** to close
this dialog box.